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Chapter 1:  Getting Started

1.1 CTC Monitor Intro:  Connecting Your Controller to the Computer

Welcome to CTC Monitor, CTC's program that enables you to view your CTC controller's I/O and
motor values, controller/program status.  CTC Monitor is also a valuable diagnostic tool for both your
controller and the Quickstep program that runs on it.  CTC Monitor supports CTC 2000 Series (except
the Model 2200) and all 5000 Series controllers.  It runs on Windows XP, Windows 7 and Windows 8.

Connecting Your Controller to the Computer

Serial (RS-232) Connection
Your controller may be connected using a cable that has modular jack connectors on each
end, which may be ordered from CTC by calling 888.818.2600.  For additional convenience,
the cable may be ordered in any one of several different lengths:

P/N 2881:  Modular Jack Cable (7' length)
P/N 2882:  Modular Jack Cable (15' length)
P/N 2883:  Modular Jack Cable (25' length)

You will additionally need a Modular Jack Adapter P/N 2880B, a DB-9 female connector that
plugs into an IBM-PC compatible RS-232 port.
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You may also make your own adapter using the following pinouts plus an RJ-11(4-pin) or RJ-
12 (6-pin) connector for the controller end of the cable:

Pin Mappings for COM port 
(on controller)

Pin Mappings for DB-9 Connector 
(on cable to Computer)

1.  TxD Outbound (Comm1)2

2.  TxD Outbound (Comm0) goes to: Pin 2:  (RxD) Inbound

3.  Common goes to: Pin 5:  (Signal Ground)

4.  Common

5.  RxD Inbound (Comm0) goes to: Pin 3:  (TxD) Outbound

6.  RxD Inbound  (Comm1)2

NOTES:
1. Model 5300 Controllers have a USB mini port on the CPU module that may be used for RS-

232 communications.  You may connect from the USB port on your computer to the USB
mini port on the Model 5300 using a standard USB cable instead of the CTC cables listed
above.

2. Comm1 is only available on controller models that have multiple COM ports.
3. All CTC COM ports use RJ-12 female receptacles. RJ-11 connectors can mate with RJ-12

receptacles.
  
Ethernet Connection
Model 2600XM, 2700 and all 5000 series controllers may be connected via Ethernet
connections.  Model 2600XM and 2700 controllers must have an Ethernet card installed.

Consult the Communications Setup section for additional information on establishing
communications between your controller and the computer.
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1.2 CTC Monitor Window

The main selection dialog box appears when CTC Monitor is started. The items on this dialog box may
be accessed manually or by DDE conversation. 

Button descriptions are discussed in the next section.

To view / change Network Settings, on the main CTCMon screen click on the second pull-down menu
called Configuration.  Select Change Configuration to go to the Network Settings window. 

To view/change Real Time Clock Settings, on the main CTCMon screen click on the second pull-down
menu called Configuration.  Select Set Real Time Clock  to go to the Controller Real Time Clock
window.
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1.3 CTC Monitor Window Buttons

Registers:  Clicking the Registers button displays the Registers dialog box. From the Registers dialog
box you can:

· View the values stored in registers

· Store a new value in a register

· Store a value in an empty register

Inputs:  Clicking the Inputs button displays the Inputs dialog box. From the Inputs dialog box you can
monitor the current state of digital inputs.

Analog Inputs:  Clicking the Analog Ins button displays the Analog Inputs dialog box. From the
Analog Inputs dialog box you can monitor the values of analog inputs.

Flags:  Clicking the Flags button displays the Flags dialog box. From the Flags dialog box you can
view or change the status of a flag.

Outputs:  Clicking the Outputs button displays the Outputs dialog box. From the Outputs dialog box
you can view the state of a digital output and turn outputs on and off.

Analog Outputs:  Clicking the Analog Outs button displays the Analog Output dialog box. From the
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Analog Output dialog box you can monitor the current value of analog outputs and change their values.

Servos:  Clicking the Servos button displays the Servo Motors dialog box. From the Servo Motors
dialog box you can view the current position of a servo motor and monitor the servo error.

Custom 1 and Custom 2:  Clicking the Custom 1 or Custom 2 buttons displays the Custom dialog
boxes. From these dialog boxes you can create custom dialog boxes that allow you to monitor a
variety of controller resources, inputs, outputs, and servo positions and errors values.

Program Step Status:  Clicking the Program Step Status button gives you real time monitoring of
your Quickstep program. The Program Status dialog box displays a tree structure of the current
running tasks.

Start:  When pressed, the program in the controller currently connected will start. If no controller has
been connected, an error message will be displayed.

Data Table:  Clicking the Data Table button displays the Data Table dialog box. From the dialog box
you can perform real time monitoring of a data table. You can also change the values in a data table
and enter messages in the data table.

Stop:  When pressed, the program in the controller currently connected will stop. If no controller has
been connected, an error message will be displayed.

Upper NVRegisters:  Clicking the Upper NVRegisters button displays the NVRegisters dialog box.
From the NVRegisters dialog box you can do the following:

· View the values stored in the NV registers

· Store a new value in an NV register

· Store a value in an empty NV register.

Reset:  When pressed, the controller currently connected will be reset. Any running program will stop,
and the controller will restart with it’s default configuration. If no controller has been connected, an
error message will be displayed.

Suspend/Resume Monitoring:  When pressed, CTC Monitor will stop communications to the
controller. This will allow other programs to communicate with the controller without having to reload
CTC Monitor later. An example of it’s use is to return to Quickstep and download a new program to the
controller, then restart CTC Monitor.
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Controller Operating Status:  Lists the status of the controller’s dedicated inputs and operating
status of the controller. You cannot change the state of the dedicated inputs from this dialog box; that
can only be done by turning the appropriate input on or off.

Operating Status also lists the following information:

· If the controller running, stopped, or waiting for an input

· If it is in normal mode

· If it status is OK or if it has a fault condition

1.4 Communications Setup

Before you can use CTC Monitor to monitor your controller, you must indicate the type of
communications used in the Configuration Setup dialog box. From this dialog box you specify the
communications port used for RS-232 communications or the computer and controller node numbers
for Ethernet communications.

All CTC controllers support RS-232 communications. Depending on controller model, controllers have
one or more RS-232 ports. 2600XM and later model controllers can support Ethernet
communications. 

The Communication Setup dialog box appears when you select  Change Configuration from the
Configuration menu. 

To connect to a given controller, enter its IP address in the IP Address field.  To change the
controller's network addresses, click on the blue link to open the network settings window.
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1.5 Network Settings Window

You must be connected to your controller to view and change these settings. Enter the new settings
and click on the Apply button to save them. Once saved, the following message with appear. You
must cycle power to your controller for the new settings to take effect. 

Notice the IP Address and Target Node fields on the Communications Setup screen are automatically

updated with the new settings for you.
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1.6 Controller Real Time Clock Window

You must be connected to your controller to view and change these settings. Click on the Sync. with
System Clock button to synchronize your PC system clock with your controller.
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Chapter 2:  Monitoring
Controller Resources

2.1 Registers Dialog Box

The Register dialog box appears when you press the Registers button on the CTC Monitor window. 

Display:  Controls how the contents of the registers are displayed. The menu toggles the register
value list between decimal values or as hex values:

NOTE: You can only enter numbers as decimal values even if the Register dialog box is displaying
values as Hex notation.

Register Name List:  Displays the register names. If you don’t choose a symbol table, the names
displayed default to reg_ plus the register number (reg_10). When you select a symbol table, the list
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displays the symbol names for the registers. To display an entire symbol name, resize the window:
only the name list will expand.

Register Value List:  Displays the current numeric value for the registers shown. When a new value is
entered into the text box, CTC Monitor downloads the value to the corresponding register in the
controller.

Register Number List:  Displays the register number.

Register Scroll Bar:  Allows for quick scanning through the register list.

Decimal or Hex Notation:  Indicates if the register values are in decimal or Hex notation.

NOTE: You can only enter numbers as decimal values even if the Register dialog box is displaying
values as Hex notation.

Register Jump Box

Allows you to change the range of registers displayed. Entering a register number in the jump box
changes the range of registers displayed to start with the number entered. If you enter a number that
exceeds the register listing, CTC Monitor displays the last range of available registers.

2.2 Monitoring Registers

Viewing Register Values

To view the values stored in registers, select the Registers button on the CTC Monitor window. The
Registers dialog box appears.

To display a new range of registers, enter the number of the register in the Register Jump Box and
press Enter.

Changing or Entering the Value in a Register

To enter or change a value in a register:

1. Select the Registers button on the CTC Monitor window.

2. The Register dialog box appears.

3. If necessary, enter the number of the register in the Register Jump Box and press Enter.

4. Select the register box by double clicking it with the mouse.

5. Type the new value.

6. Press ENTER.

7. CTC Monitor downloads the new value to the controller.

2.3 Flags Dialog Box

The Flag dialog box appears when you press the Flags button on the CTC Monitor window. 
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Flag Name List:  Displays the flag names. If you don’t choose a symbol table, the names displayed
default to flag_ plus the flag number (flag_2). When you select a symbol table, the list displays the
symbolic names for the flags. To display an entire symbolic name, resize the window: only the name
list will expand.

Flag State List:  Displays the current state for the flags shown. Flags are either set or clear. When
you change the state of a flag, CTC Monitor downloads the new state to the corresponding flag in the
controller.

Flag Number List:  Displays the flag number.

Flag Scroll Bar:  The scroll bar allows for quick scanning through the flag list.

Flag Jump Box:  Allows you to change the range of flags displayed. Entering a flag number in the
jump box changes the range of flags displayed to start with the number entered. If you enter a number
that exceeds the flag listing, CTC Monitor displays the last range of available flags.

2.4 Monitoring Flags

Viewing Flag States

To view the state of a flag, select the Flags button on the CTC Monitor window. The Flags dialog box
appears.

To display a new range of flags, enter the number of the flag in the Flag Jump Box and press Enter.

Changing the State of a Flag
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To change a flag’s state:

1. Select the Flags button on the CTC Monitor window.

The Flags dialog box appears.

2. If necessary, enter the number of the Flag in the Flag Jump Box and press Enter.

3. Use the mouse pointer to click the State Button of the flag whose state you want to change.

The State Button changes and CTC Monitor downloads the changed state to the controller.

2.5 Digital Input Dialog Box

The Digital Input dialog box appears when you press the Inputs button on the CTC Monitor window.  

Digital Input Name List: Displays the names of the digital inputs. If you don’t choose a symbol table,
the names displayed default to in_ plus the input number and A for open inputs, or B for closed inputs (
in_1A or in_2B). When you select a symbol table, the list displays the symbolic names for the inputs.
To display an entire symbolic name, resize the window: only the name list will expand.

Digital Input State:  Displays the current state for the digital inputs shown. ON means that the digital
input is currently pulled to Ground; OFF means that the digital input is currently at + 24 volts.

Digital Input Number List:  Displays the input number for the digital inputs shown.
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Digital Output Scroll Bar:  The scroll bar allows for quick scanning through the digital output list.

Digital Input Jump Box:  Allows you to change the range of inputs displayed. Entering an input
number in the jump box changes the range of digital inputs displayed to start with the number entered.
If you enter a number that exceeds the digital input listing, CTC Monitor displays the last range of
available digital inputs.

2.6 Monitoring Digital Inputs

To view the state of a input, select the Inputs button on the CTC Monitor window. The Digital Inputs
dialog box appears.

To display a new range of inputs, enter the number of the input in the Digital Input Jump Box and
press Enter

2.7 Digital Output Dialog Box

The Digital Output dialog box appears when you press the Output button on the CTC Monitor window
is pressed. 

Digital Output Name List:  Displays the names of the digital outputs. If you don’t choose a symbol
table, the names displayed default to OUT_ plus the output number and on or off (OUT_1_OFF).
When you select a symbol table, the list displays the symbol names for the outputs. To display an
entire symbol name, resize the dialog box: only the name list will expand.

Digital Output State List:  Displays the current state for the digital outputs shown. Digital outputs are
either on or off. When you turn an output on or off, CTC Monitor downloads the new state to the
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controller, and the controller changes the state of the corresponding output.

Digital Output Number List:  Displays the digital output number for the digital outputs.

Digital Output Scroll Bar:  The scroll bar allows for quick scanning through the digital output list.

Digital Output Jump Box:  Allows you to change the range of outputs displayed. Entering an output
number in the jump box changes the range of digital outputs displayed to start with the number
entered. If you enter a number that exceeds the digital output listing, CTC Monitor displays the last
range of available digital outputs.

2.8 Monitoring Digital Outputs

Viewing Output States

To view the state of an output, select the Outputs button on the CTC Monitor window. The Outputs
dialog box appears.

To display a new range of outputs, enter the number of the output in the Output Jump Box and press
Enter.

Turning Digital Outputs On and Off

To turn change the output on or off:

1. Select the Outputs button on the CTC Monitor window.

The Digital Outputs dialog box appears.

2. If necessary, enter the number of the output in the Digital Output Jump Box and press Enter.

3. Use the mouse pointer to click the State Button of the output you want to turn on or off. 

The State Button changes and CTC Monitor downloads the changed output state to the
controller.

2.9 Analog Input Dialog Box

The Analog Input dialog box appears when you press the Analog Ins button on the CTC Monitor
window. 
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Analog Input Name List:  Displays the names of the analog inputs. If you don’t choose a C, the
names displayed default to ain_ plus the analog input number (ain_1). When you select a symbol
table, the Register menu displays the symbolic names for the inputs. To display an entire symbolic
name, resize the window, only the name list will expand.

Analog Input Value:  Displays the current numeric value for the analog inputs shown.

Analog Input Number List:  These labels display the analog input number for the analog outputs
shown. When using symbolic names where the analog input number may not be included, these labels
always display the number of the controller analog input shown.

Analog Input Scroll Bar:  The scroll bar allows for quick scanning through the analog input list.

Analog Input Jump Box:  Entering an analog input number in this text box causes the range of
analog inputs starting at the number entered to be displayed. If the number entered exceeds the
analog input listing, the last range of available analog inputs is shown.

2.10 Monitoring Analog Inputs

To view the state of a input, select the Analog Ins button on the CTC Monitor window. The Analog
Inputs dialog box appears.

To display a new range of inputs, enter the number of the input in the Analog Input Jump Box and
press Enter.
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2.11 Analog Output Dialog Box

The Analog Output dialog box appears when you press the Analog Outs button on the CTC Monitor
window.  

Analog Output Name List:  Displays the names of the Analog outputs. If you don’t choose a symbol
table, the names displayed default aout_ plus the analog output number (aout_2). When you select a
symbol table, it displays the symbolic names for the outputs. To display an entire symbolic name,
resize the dialog box, only the name list will expand.

Analog Output Value List:  Displays the current value for the analog outputs shown. When you enter
a new value for an output, CTC Monitor downloads the new value to the controller, and the controller
enters the new value in the corresponding output.

Analog Output Number List:  These labels display the analog output number for the analog outputs
shown. When using symbolic names where the analog output number may not be included, these
labels always display the number of the controller analog output shown.

Analog Output Scroll Bar:  The scroll bar allows for quick scanning through the analog output list.

Analog Output Jump Box:  Allows you to change the range of analog outputs displayed. Entering a
number in the jump box changes the range of analog outputs displayed to start with the number
entered. If you enter a number that exceeds the analog output listing, CTC Monitor displays the last
range of available analog outputs.
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2.12 Monitoring Analog Outputs

Viewing Analog Outputs

To view the value of an analog output, select the Analog Outs button on the CTC Monitor window.
The Analog Outputs dialog box appears.

To display a new range of outputs, enter the number of the output in the Analog Output Jump Box
and press Enter.

Changing Analog Output Values

To change an output value:

1. Select the Analog Outs button on the CTC Monitor window.  
The Analog Outputs dialog box appears.  
If necessary, enter the number of the output in the Analog Output Jump Box and press Enter.

2. Use the mouse pointer to select the analog output whose value you want to change.

3. Type the new value.

4. Press Enter.

CTC Monitor downloads the new value to the controller.

2.13 ServoMotors Dialog Box

The ServoMotors dialog box appears when you press the Servos button on the CTC Monitor window. 

Servo Name List:  Displays the servo names. If you don’t choose a symbol table, the names default
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to servo_ plus the servo number (servo_1). When you select symbol table, the list displays the
symbolic names. To display an entire symbolic name, resize the dialog box: only the name list will
expand.

Servo Position Value List:  These text boxes display the current position value for the servos shown.
When a new value is entered into the text box, the entered value is downloaded to the corresponding
servo in the controller.

To enter a new servo position value:

1. Select the desired servo position text box by clicking on it with the mouse.

2. Type in the new value.

3. Press the ENTER key.

Servo Error Value List

These text boxes display the current error value for the servos shown.

2.14 Monitoring Servo Position and Error

To view servo position and error values, select the Servos button on the CTC Monitor window. The
ServoMotors dialog box appears.

To Enter a New Servo Position Value

1. Select the Servos button on the CTC Monitor window.The ServoMotors dialog box appears.

2. Select the servo position text box by double clicking it with the mouse.

3. Type in the new value.

4. Press Enter.

CTC Monitor downloads the new value to the controller.

2.15 NVRegisters Dialog Box

The NVRegisters dialog box appears when you press the Upper NV Registers button on the CTC
Monitor window. The NVRegisters dialog box provides access to extended registers 32001 through
48000.



Monitoring Controller Resources 23

Doc. No.  951-000020-002

NVRegisters Name List:  Displays the NVRegister names. If you don’t choose a symbol table, the
names displayed default to reg_ plus the register number (reg_32001). When you select a symbol
table, the list displays the symbol names for the registers. To display an entire symbol name, resize the
window: only the name list will expand.

NVRegister Value List:  Displays the current numeric value for the registers shown. When a new
value is entered into the text box, CTC Monitor downloads the value to the corresponding register.

NVRegister Numbers List:  Displays the register number.

NVRegister Scroll Bar:  The scroll bar allows for quick scanning through the register list.

NVRegister Jump Box:  Allows you to change the range of registers displayed. Entering a register
number in the jump box changes the range of registers displayed to start with the number entered.

2.16 Monitoring NVRegisters

Viewing NVRegister Values

To view the values stored in registers, select the Upper NVRegisters button on the CTC Monitor
window. The NVRegisters dialog box appears.

To display a new range of registers, enter the number of the register in the Register Jump Box and
press Enter.

Changing or Entering the Value in an NVRegister
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To enter or change a value in an NVRegister register:

1. Select the Upper NVRegisters button on the CTC Monitor window.
The NVRegisters Module dialog box appears.

2. If necessary, enter the number of the register in the Register Jump Box and press Enter.

3. Select the register box by double clicking it with the mouse.

4. Type the new value.

5. Press ENTER.

CTC Monitor downloads the new value to the controller.

2.17 Program Status Dialog Box

The Program Status dialog box appears when you press the Program Step Status button on CTC
Monitor. It displays a tree structure of the currently running tasks.

Controller Status Messages:  The Controller Status Message box indicates the current controller
status and displays user prompts.

2.18 Reading System Fault Messages

When your controller has a fault condition, the Program Status List displays messages that can help
you diagnose the problem. The Program Status List displays the step where the fault occurred and a
message. A list of system default messages is on the next page.

To obtain a system fault message, select the Program Step Status button on the CTC Monitor
window. The Program Status dialog box appears. To see an entire fault message, expand the dialog
box to full size and read the message in the program status list.
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The following table lists the system fault messages:

1. Illegal Function

2. Corrupt Program Data

3. Destination Step is Empty

4. Bad Thumbwheel Data

5. Step#1 is Empty

6. Too Many Tasks

7. No Such Stepper Motor

8. Motor Not Ready

9. Motor Unprofiled

10.Servo # does NOT exist

11.Servo# Is Not Ready

12.Servo# Error

13.Register# does NOT exist

14.Data Table Column# does NOT exist

15.Data Table Row# does NOT exist

16.No Such Proto Board

17.Illegal Sample Time

18.Analog Input# does NOT exist

19.Analog Output# does NOT exist

20.Display# does NOT exist

21.Digital Input# does NOT exist

22.Digital Output# does NOT exist

23.Thumbwheel# does NOT exist

24.Illegal Data Table Value

25.Message Transmitting Busy

26.Divide-By-Zero Error

27.Caused by Register# or Data Out of Range

28.Watch dog / Hardware Fault

29.Error Network Fault

30.Network Access Time-out



26

CTC Monitor v3.2

Control Technology Corp.

Chapter 3:  Creating Custom
Dialog Boxes

3.1 Creating Custom Dialog Boxes

CTC Monitor gives you the option of creating custom dialog boxes that allow you to monitor a variety of
controller resources, inputs, outputs, and servo positions and errors values. To access the custom
dialog boxes select the Custom 1 or Custom 2 buttons on the CTC Monitor window. Each custom
dialog box can list up to 16 different resources. You can create custom dialog boxes and save them for
monitoring different machines or processes.

There are two different Custom Display dialog boxes. The Resource Display dialog box is for creating
custom dialog boxes, and the Label Display dialog box is used to view the information.

3.2 Label Display Dialog Box

The Label Display dialog box appears when you press the Custom 1 or Custom 2 button on CTC
Monitor window. The Label Display dialog box is used to view custom dialog boxes.

Custom File Menu Commands

New:  Clears the existing custom resource display. All resource listings in the workspace are
returned to the non-selected state.

Open:  Loads an existing custom resource CFG file from disk. The resource configuration
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saved in the file will be used to update the display listing in the workspace.

Save:  Saves the existing custom resource configuration displayed to a .CFG file. The
resource configuration saved in the file can be recalled for later use in the workspace.

Save As:  Saves the existing custom resource dialog box configuration to a new .CFG file.
You can recall the Custom Resource dialog box configuration saved in the file for later use.

Exit:  Closes the Custom Resource dialog box.

Custom Dialog Box Display Menu Commands

Display Labels:  Displays the Label Display dialog box and shows a listing of controller
resources using the symbolic names (if loaded) and their values. The resources displayed are
the ones defined by the current Custom Resource dialog box or .CFG file.

Display Resources:  Displays the Custom Resource dialog box and shows a resource listing.
From this dialog box you can change the controller resources listed.

Label Resource List:  Displays the symbolic names for the controller resources chosen. To choose a
new resource, select Display Resources from the Display menu.

Resource Value List:  Displays the current value for the controller resource chosen. A new value may
be entered in the appropriate text box for controller resources that accept input.

NOTE: You cannot update the value of all the resources displayed.

3.3 Resource Display Dialog Box

The Resource Display dialog box appears when you press the Custom 1 or Custom 2 button on CTC
Monitor window. The Resource Display dialog box is used to create custom dialog boxes.
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Custom File Menu Commands

New:  Clears the existing custom resource display. All resource listings in the workspace are
returned to the non-selected state.

Open:  Loads an existing custom resource CFG file from disk. The resource configuration
saved in the file will be used to update the display listing in the workspace.

Save:  Saves the existing custom resource configuration displayed to a .CFG file. The
resource configuration saved in the file can be recalled for later use in the workspace.

Save As:  Saves the existing custom resource dialog box configuration to a new .CFG file.
You can recall the Custom Resource dialog box configuration saved in the file for later use.

Exit:  Closes the Custom Resource dialog box.

Custom Dialog Box Display Menu Commands

Display Labels:  Displays the Label Display dialog box and shows a listing of controller
resources using the symbolic names (if loaded) and their values. The resources displayed are
the ones defined by the current Custom Resource dialog box or .CFG file.

Display Resources:  Displays the Custom Resource dialog box and shows a resource listing.
From this dialog box you can change the controller resources listed.

Display Resource List:  Displays a drop down list of controller resources. When you select a
resource, CTC Monitor evaluates the resource number to make sure it is a valid resource. The custom
resource value list field immediately displays the current value or state of the resource.

Resource Numbers List:  Specifies and displays the number for the controller resource chosen.
Enter the number of the resource in the appropriate text box. When you enter the new resource
number, the custom resource value list field immediately displays the current value or state of the
resource.

Resource Value List:  Displays the current value for the controller resource chosen. A new value may
be entered in the appropriate text box for controller resources that accept input.

NOTE: You cannot update the value of all the resources displayed.

3.4 Setting Up a Custom Dialog Box

When you create a new custom display dialog box, you start with an empty Resource Display dialog
box. To create a new custom display dialog box:

1. Select Custom 1 or Custom 2 button on the CTC Monitor window.

2. When the Label Display dialog box appears, select Display Resources from the Display menu.

3. Display the drop down list of controller resources, by clicking on the Not Selected field with the
mouse.

4. Choose a resource from drop down list of controller resources.

5. Select the Resource Number field by placing the mouse pointer in the field and clicking the
mouse.

6. Type in the number of the resource and press Enter.
The Resource Value field immediately displays the current value or state of the resource.

7. Continue selecting resources until you have defined your custom dialog box.
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8. To save the dialog box, select Save from the File menu and enter a name for the dialog box.

3.5 Saving a Custom Dialog Box

To save a new custom dialog box:

1. Select Save as or Save from the File menu.

2. When the Save As dialog box appears, enter a name for the new dialog box. If necessary, select
the correct directory.

3. Select OK.

Saving an Existing Custom Dialog Box

To save an existing custom dialog box, select Save from the File menu. 

3.6 Changing Values in a Custom Dialog Box

Whenever CTC Monitor is communicating with a controller, the fields on the resource value list display
the current value or state of the resources on the custom dialog box. You can change a value in a
register or analog output or change the state of a flag or digital output from a custom dialog box.

To enter a new value for a controller resource:

1. Place the mouse pointer in the resource value field and click the mouse.

2. Type in the new value or state of the resource and press the Enter.

On the Resource Display Dialog Box you can select a field in resource number list and enter a different
resource number.

1. Place the mouse pointer in the resource number field and click the mouse.

2. Type a different resource number and press the Enter.

3.7 Opening a Custom Dialog Box

You can display previously defined and saved custom dialog box by opening it. To open a custom
dialog box:

1. Select Custom 1 or Custom 2 from CTC Monitor window.

2. When the Resource Display dialog box appears, select Open from the File menu.

3. When the Open dialog box appears, select the file you want to open. If necessary, select a
different directory.

4. Select OK or press Enter.
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Chapter 4:  Monitoring Data
Tables

4.1 Data Table Dialog Box

The dialog box appears when the Data Table button on CTC Monitor is pressed.  Click the part of the
dialog box you want to know more about.

 

Data Table File Menu Commands

Open:  Opens an existing data table file. When the Load Data Table dialog box appears,
select the data table file to load.

Save:  Saves the data table to a file. 

Save As:  This command saves the data table in the workspace to a file. When the Save Data
Table dialog box appears, specify the file name.

Upload:  Uploads the data table in the controller into the workspace.

Download:  Downloads the data table to the controller.

Exit:  Closes the Data Table dialog box.

Data Table Edit Menu Commands

Cut:  Cuts the selected item and places it into the clipboard.

Copy:  Copies the selected item and places it into the clipboard.

Paste:  Inserts the contents of the clipboard into the selected position in the data table.

Data Table Options Menu Commands



Monitoring Data Tables 31

Doc. No.  951-000020-002

Font:  Allows you to change the data table display fonts.

Begin Monitoring:  Starts monitoring the data table in the controller.

End Monitoring:  Ends the data table monitoring operation.

Monitoring Setup:  Opens a Monitoring Setup dialog box. From this dialog box you select the
section of the data table to monitored and specify the monitoring update interval.

Data Table Rows

Indicates the number of rows in the data table.

Data Table Columns

Indicates the number of columns in the data table.

Data Table Rows and Columns

Displays the rows and columns in your data table. The data table is a two-dimensional array of
numbers.

Message List

Displays each row of data table elements in character-equivalent form (ASCII character
representation). You can use this area to create messages for transmission to external devices.

4.2 Setting Data Table Monitoring Parameters

CTC Monitor lets you perform real time monitoring of a data table. Using the data table monitoring, you
can check the current values in a data table while your controller is running. You can specify the
monitor time interval and the beginning and ending rows to be monitored.  You access this dialog box
by selecting Monitor Setup from the Options menu.

Click the part of the Monitor Setup dialog box you want to know more about.

 

To set the monitor parameters:

1. Select Monitor Setup from the Options menu.  Then set the time interval, starting and ending
rows as necessary.

2. To specify the time interval, place the mouse pointer on the Monitor Interval field and double click
the mouse.

3. Type the time interval and press Enter.
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4. To specify the starting or ending row to monitor, place the mouse pointer on the Starting Row to
Monitor or Ending Row to Monitor field and double click the mouse.

5. Type the row number and press Enter.

4.3 Beginning and Ending Data Table Monitoring

When data table monitoring begins, CTC Monitor uploads the data table from the controller and
displays it in the Data Table dialog box. CTC Monitor uploads the data table at the time interval
specified in the Monitor Setup dialog box. When you cancel data table monitoring, the Data Table
dialog box continues to display the last uploaded data table.

You can start and stop monitoring a data table as follows:

· To begin data table monitoring, select Begin Monitoring from the Options menu.

· To end data table monitoring, select End Monitoring from the Options menu.

4.4 Entering and Editing Numbers in the Data Table

You can enter or edit a number by typing from the keyboard or pasting it from the Clipboard.

To enter or edit a value:

1. Select the appropriate cell using the Arrow keys or mouse pointer.
The data table editor highlights the cell.

2. Type or paste the number and press Enter.The number appears in the cell.

3. To enter a value in another cell, press Enter again to move to the next cell in a row. 
You can also use the Arrow keys or mouse pointer to move to the another cell.

4. To send the new values to the controller, select Download from the File menu.

4.5 Entering Messages

Using the Data Table dialog box, you can create messages for the data table. The length of message
(letters, numbers, and spaces) cannot be longer than the number of columns in the table.

To enter a message:

1. Select the message field by placing the mouse cursor in the message field and click the mouse.
The dots in the message indicate that the corresponding cell in the data table does not contain a
number which is an ASCII code for a printing character.

2. Type the message and press Enter.CTC Monitor enters the message in the Data Table dialog
box.

3. To send the message to the controller, select Download from the File menu.

4.6 Opening a Data Table

To open an existing data table:

1. Select Open from the File menu.The Load Data Table dialog box appears.

2. Choose the name of the data table from the Load Data Table dialog box and select OK.  If the
data table is in a different directory, select the appropriate directory.

CTC Monitor opens the data table.
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4.7 Uploading and Downloading a Data Table

From CTC Monitor you can upload or download a data table from your controller to the CTC Monitor
Data Table dialog box. If there is not a data table open, use the Open command from the File menu.

· To upload a data table, select Upload from the Data Table File menu. The uploaded data table
appears in the Data Table dialog box and the message, Upload complete, appears in the Status
Message Display on the CTC Monitor window.

· To download a data table, select Download from the Data Table File menu. When CTC Monitor
has finished downloading the data table, the message, Download complete, appears in the Status
Message Display on the CTC Monitor window.

4.8 Saving a Data Table

Saving a Data Table Under an New Name

To save a data table under an new name:

1. Select Save as or Save from the File menu.

2. When the Save As dialog box appears, enter a new name for the data table. If necessary, select
the correct directory.

3. Select OK.

Saving an Existing Data Table

To save an existing data table, do one of the following:

· Select Save from the File menu (shortcut, type CTRL + S).

· Select the Save icon on the Toolbar.

4.9 Changing the Font

The data table editor displays text in Courier font. You can change the default font using the Font
dialog box.
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1. Select Font from the Options menu.

2. When the Fonts dialog box appears, select the Font, Font Style, Size, and Color.

The Sample box displays the current font.

NOTE: We do not recommend selecting the Strikeout or Underline effects.

3. Select OK to apply your changes.

4. To exit with out saving your changes, select Cancel.
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Chapter 5:  Using CTC Monitor
as a DDE Server

5.1 DDE Communications Overview

From CTC Monitor you can use dynamic data exchange (DDE) to transfer information and
communicate with another application, such as WonderWareTM, Intellution's FixTM, LabviewTM, or Excel
TM. The DDE protocol permits two applications to communicate by continuously and automatically
exchanging data through a DDE channel.

To establish DDE communications you must establish a channel, select a topic, request and send
data. The DDE channel must be specified in both applications in order for them to exchange data.

There are two different DDE dialog boxes, the Flag Register Configuration dialog box and the Block
Write Configuration dialog box. You access these dialog boxes by selecting Change DDE Setup from
the Configuration menu on the CTC Monitor window. Selecting Change DDE Setup  displays the Flag
Register Configuration dialog box. To display the Block Write Configuration dialog box select the Block
Write Configuration tab.

5.2 Flag Register Configuration Dialog Box

From the Flag Register Configuration dialog box you can set up a DDE conversation that can read or
change a specific flag or register. From this dialog box you can also read the state of all the flags and
specify a block of 50 registers to be read at one time.
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Flag Write Address

Sets the flag address to write data to a specific flag. If the flag address is 0, the DDE application
cannot display the flag data. The DDE conversation must establish the correct flag address here
before sending the new data to the Flag Write Data box.

The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  FlagAddress

Flag Write Data

Displays the current state of the flag specified in the Flag Write Address box. If the flag is set, its value
is 1; if the flag is clear, its value is 0.

The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  FlagWrite

Flag Data List

Displays the flag data. If the flag is set, its value is 1; if the flag is clear, its value is 0.
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The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  FlagValue (1 - 32, 0 = inactive)

Register Write Address

Allows you to set the register address so that the DDE conversation can write data to a specific
register. The DDE conversation must establish the correct register address here before sending the
new data. If the register address is 0, the DDE application cannot write to the register.

The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  RegAddress

Register Write Data

Allows the DDE conversation to change the value for the register specified in the Single Register Write
Address box.

The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  RegWrite

50 Register Read Address

Specifies a block of 50 registers to read. The data for the 50 register block selected is displayed in the
Register Data listing. Register block addressing may be used to read registers 1 - 1000.  Since the
registers are displayed in blocks of 50, you must enter a value from 1 to 20 to access the
corresponding block of registers.  For example, entering 13 would display the values in registers 601
through 650.

If the register address is 0, the DDE application cannot display the register block data.

The DDE link for this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  Reg50Address

Single Register Read Data

Displays the current value of the register specified in the Single Register Write Address box.

The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  RegRead
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Register Data List

Displays the data for the register block selected in the 50 register read address box.

The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  RegValue (1 - 50, 0 = inactive)

5.3 Block Write Configuration Dialog Box

From the Block Write Configuration dialog box you can specify a set of up to 16 registers to read and
write to as a block. These registers can be any register in the controller you have read or write access
to. Selecting the Block Write Configuration tab displays the dialog box.

 

Update Interval:  Displays the current update time in milliseconds that the DdeSetup screen uses to
update its controls. A value from 10 ms to 10000 ms (0.01 to 10 seconds) may be entered using the
scroll bar. Use  the scroll bar thumb for gross adjustments and the scroll bar arrows for fine
adjustments.  200 ms or greater interval recommended.
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The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  DdeInterval

Message Area:  Displays the current state of the monitor program communication with your controller.

The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  Message

Start/Cancel Button:  Toggles between the monitoring of the controller and the updating of the DDE
Setup screen. Any DDE conversation that supports command execution can access this button.

The DDE link to this control is:

Application:  CTCMON
Topic:  DdeSetup
Item:  START

Exit Button:  Exits the DDE Setup screen and returns to the CTC Monitor main screen. Any DDE
conversation that supports command execution can access this button.

The DDE link to this control is:

Application:  CTCMON
Topic:  DdeSetup
Item:  EXIT

Block Register Address:  Allows you to specify which register addresses to write data to during a
Block Register Write operation.  If the register address is 0, any new write value is ignored, and the
DDE application cannot display the register data.

The DDE link to this information is:

Application: CTCMON
Topic: DdeSetup
Item: BlockAddress (1 - 16, 0 = inactive)

Block Register Write Value:  Allows DDE conversations to change the value for the registers
specified in the Block Register Address boxes.

The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  BlockWrite (1 - 16, 0 = inactive)
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Block Register Read Value:  Displays the values for the register specified in the block register
address shown.

The DDE link to this information is:

Application:  CTCMON
Topic:  DdeSetup
Item:  BlockRead (1 - 16, 0 = inactive)

Write Block Data Button:  Writes all block write register data changes. Any DDE conversation that
supports command execution can access this button.

The DDE link to this control is:

Application:  CTCMON
Topic:  DdeSetup
Item:  DOWNLOAD

For applications that do not support command execution through DDE conversations, you can
duplicate the action of this button by writing the value 1 to the hidden WriteBox control.

The DDE link to this control is:

Application:  CTCMON
Topic:  DdeSetup
Item:  WriteBox

5.4 Opening a DDE Communications Channel

To establish or open DDE communications you must establish a channel, select a topic, and request
and send data. Depending on what type of information you want, you may either leave the channel
open to receive continual updates from the controller via CTC Monitor or you can close the channel
after the initial data exchange. The DDE channel must be specified in both applications in order to
exchange data.

You open a DDE channel and establish communications from the Block Write Configuration dialog
box.

1. Start CTC Monitor.

2. Select DDE Setup from the Configuration menu.

3. When the DDE Configuration dialog box appears, select the tab for the Block Write
Configuration dialog box.

4. Enter the update interval in the DDE Update Interval field. The update interval is specified in
milliseconds. 
CTC does not recommend using an interval shorter than 200 milliseconds.

5. Select the Start DDE button by clicking it with the mouse.

6. After starting DDE from CTC Monitor, start the DDE application.

5.5 Reading Data from CTC Monitor

You can read the state of a flag or the value of a register using a DDE application. Before you can read
information from CTC Monitor, you must open a DDE channel between CTC Monitor and the DDE
application. See Opening a DDE Communications Channel.

To read the information you must specify the DDE link for the field on the Flag Register Configuration



Using CTC Monitor as a DDE Server 41

Doc. No.  951-000020-002

or Block Write Configuration dialog box. The link contains the application name, topic and item. For
example, the DDE link to read a flag’s state is:

Application:  CTCMON
Topic:  DdeSetup
Item:  FlagValue (1 - 32, 0 = inactive)

Set up the DDE application as follows:

1. Open the DDE application.

2. To start the DDE exchange, specify the application name, topic, and item.
For example, to read a flag state, you would enter:

=CTCMON|DdeSetup!'FlagValue(1)

'Where (1) specifies the first flag in the Flag Data List on the Flag Register Configuration dialog
box. Some DDE applications require single quotes around FlagValue(1) when specifying an item
from an array. Make sure you have the correct format for your DDE application.

3. If you have the DDE server running from CTC Monitor when you are setting up your DDE
application, the information from the controller appears in the appropriate field.

5.6 Overview - Writing to CTC Monitor from a DDE Application

In addition to reading flag states and register values, you may set up a DDE conversation with CTC
Monitor to change a flag’s state and write values to registers. This is done by specifying the DDE
information for a specific flag or register and then sending the changes to CTC Monitor. You can set
up the links to either the Flag Register Configuration dialog box or to the Block Write Configuration
dialog box.

In both cases you must specify the following information:

· The flag or register number 

· The new state or value

· Assign a Visual Basic macro to send the flag or register number and value to CTC Monitor.

Once you have written the macro, you must design a method of executing the macro. One method of
executing the macro is to create a button and assign the macro to it. For instructions on how to create
a macro, see the documentation for your DDE application. For sample macros, see Appendix  B, 
Sample Visual Basic Macros for DDE Applications. In the CTC Monitor User Guide available from
Control Technology’s web site (www.ctc-control.com).

5.7 Using DDE to Write to the Flag Register Configuration Dialog Box

When entering or changing flag or register values using the Flag Register Configuration dialog box,
you need to specify the following information:

· The flag or register number by writing to one of the following fields Flag Write Address and Single
Register Write Address on the Flag Register Configuration dialog box. The DDE information for
this is:

Application: CTCMON
Topic: DdeSetup
Item: RegAddress for registers
Item: FlagAddress for flags

· The new value by writing to the Single Register Write Data field. The DDE information for this is:



42

CTC Monitor v3.2

Control Technology Corp.

Application: CTCMON
Topic: DdeSetup
Item: RegWrite for registers
Item: FlagWrite for flags

Before you can write new values to a flag or register, you must open a DDE channel between CTC
Monitor and the DDE application. See Opening a DDE Communications Channel.

To write to the Flag Register Configuration dialog box:

1. Start the DDE application and enter the following information in it.

2. Enter the application name, topic, and item for the Single Register Write Address field or Flag
Write Address field.

3. Enter the application name, topic, and item for the Single Register Write Value field or Flag Write
Data field.

4. The DDE application displays the current register or flag address and the register value or flag
state.

5. Create the Visual Basic Macros required to access the RegAddress and RegWrite or FlagAddress
and FlagWrite fields on the Flag Register Configuration dialog box. Refer to the documentation for
your DDE application for information on creating Visual Basic Macros. For sample macros, see
Appendix  B, Sample Visual Basic Macros for DDE Applications. In the CTC Monitor User Guide
available from Control Technology’s web site (www.ctc-control.com).

6. In the DDE application, specify a register by entering the register number in the RegAddress field
or specify a flag by entering the flag number in the FlagAddress field. 

7. In the DDE application, write a new value to the register by entering it in the RegWrite field or
specify a different flag state by entering it in the FlagWrite field.

8. Execute the Visual Basic Macros to send the information to CTC Monitor.

Once CTC Monitor receives the information, it downloads the new value to the controller.

5.8 Using DDE to Write to the Block Write Configuration Dialog Box

When entering or changing register values using the Block Configuration dialog box, you need to
specify the following information:

· The register number by writing to Block Register Address on the Block Write Configuration dialog
box. The DDE information for this is:

Application:  CTCMON
Topic:  DdeSetup
Item:  BlockWrite (1 - 16)

· The new value by writing to the Block Register Write Value field. The DDE information for this is:

Application:  CTCMON
Topic:  DdeSetup
Item: Block Write (1 – 16)

· Execute the download function on the Block Write Configuration dialog box. The DDE information
for this is:

Application:  CTCMON
Topic:  DdeSetup
Item:  DOWNLOAD

If your application does not support command execution through DDE conversations, you can
duplicate the action of the Write Block Data button by using the following DDE command:
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Application:  CTCMON
Topic:  DdeSetup
Item:  WriteBox

Before you can write new values to a flag or register, you must open a DDE channel between CTC
Monitor and the DDE application. See Opening a DDE Communications Channel.

To write to the Flag Register Configuration dialog box:

1. Start the DDE application and enter the following information in it.

2. Enter the application name, topic, and item for the Block Register Write Value field.

3. Enter the application name, topic, and item for the Block Register Write Value field.

4. Enter the application name, topic, and item for the Block Write Data button.

5. The DDE application displays the current register value.

6. Create the Visual Basic Macros required to access the BlockAddress, BlockWrite, DOWNLOAD
fields on the Block Write Configuration dialog box. Refer to the documentation for your DDE
application for information on creating Visual Basic Macros. For sample macros, see Appendix  B, 
Sample Visual Basic Macros for DDE Applications. In the CTC Monitor User Guide available from
Control Technology’s web site (www.ctc-control.com).

7. In the DDE application, specify a register by entering the register number in the BlockAddress
field.

8. In the DDE application, write a new value to the register by entering it in the BlockWrite field.

9. Execute the Visual Basic Macros to send the information to CTC Monitor.

Once CTC Monitor receives the information, it downloads the new value to the controller.
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Chapter 6:  File Transfers

6.1 File Transfer Overview

CTC Monitor enables you to transfer files between your computer and the controller.  CTC Monitor
supports the following operations:

· opening symbol and register files on your computer,

· uploading register and Quickstep files from your controller to your computer,

· downloading register and Quickstep files from your computer to your controller.

You can use file transfer functions to create backups of your controller or make edits and upgrades to
existing programs.  

6.2 Open Symbol File

Symbols are used in Quickstep to define meaningful names for program steps and for resources such
as I/O and axes.  Symbols are organized in a table in Quickstep, and this table may be exported as a 
.sym file  for use in other Quickstep programs.  To open a symbol file on your computer and download
it to the controller:

1. Select  Open Symbol File... from the File menu:

2. Select a .sym file from your computer:
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3. The Controller Operating Status Window on the CTC Monitor Main Screen will momentarily display
a message of New Symbol Database created:

                                 

6.3 Open Register File

Registers are resources in the controller that are used to store information about the controller's
configuration, status, I/O values, user-defined values, and more.  You may use CTC Monitor's Upload
Register File command to upload a snapshot of register values from the controller and save them as
a .txt file.  The Open Register File... command enables you to open, edit and save the register values.
 To open a register file:
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1. Select  Open Register File... from the File menu:

2. Select a .txt register file from your computer:

3. Click the Open button to view the register file with your designated text editor.  You may edit the
values in the file, save the file and then use the Download Register File command to download the
edited values back to the controller.

 

WARNING:  Changing register values can have serious consequences that may
injure people or equipment.  Edits should only be done by experienced
individuals who are  familiar with both the controller and the application.

                                 

6.4 Upload Register File

Registers are resources in the controller that are used to store information about the controller's
configuration, status, I/O values, user-defined values, and more.  The Upload Register File command
uploads a snapshot of register values from the controller and saves them as a .txt file on your
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computer.  To upload a register file from the controller to your computer:

1. Select Upload Register File from the File menu:

2. Enter a name for your register file:

3. Click the Save button to view the register file with your designated text editor.  

                                 

6.5 Download Register File

Registers are resources in the controller that are used to store information about the controller's
configuration, status, I/O values, user-defined values, and more.  The Download Register File
command downloads a file that contains a new set of register values that will then update the
controller.  
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WARNING:  Changing register values can have serious consequences that may
injure people or equipment.  Edits should only be done by experienced
individuals who are  familiar with both the controller and the application.

To download a register file from the controller to your computer:

1. Select Download Register File from the File menu:

2. Select the register file you want to download:

3. Click the Open button to download the register file to the controller.  The Controller Operating
Status Window on the CTC Monitor Main Screen will momentarily display a message of Registers
401 to 500 downloaded!:
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6.6 Program Transfer (Quickstep Based) - Uploads

The Program Transfer Utilities enable you to move your Quickstep program back and forth between
the controller and your computer.    Once you have uploaded your program from the controller, the
CTC Utilities may be used to decompile the .dso file for editing.  Contact  CTC Sales  to order CTC
Utilities.

To upload a Quickstep file from the controller to your computer:

1. Select Program Transfer (Quickstep Based) from the File menu:



50

CTC Monitor v3.2

Control Technology Corp.

2. The Program Transfer Utility pop-up appears:

3. To upload the program from your controller to the computer, select the 1 button for Quickstep
Program Upload:
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4. Enter a name for the .dso file when prompted and click the Save button:

5. You will see a pop-up asking you if you want to save the registers:

Select the Yes button and you will see another pop-up when the upload is complete:

Click OK and your program and register values are uploaded.  

6. Click on the Exit button of the Program Transfer Utility pop-up to return to the main screen:
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NOTE:  To transfer programs to and from the Model 2200 controller, use the Legacy CT Load v2.0
Utility, available as a download from http://www.ctc-control.com/customer/downloads/ctLoadLegacy/
ctLoadSetup20.zip.
                     

6.7 Program Transfer (Quickstep Based) - Downloads

The Program Transfer Utilities enable you to move your Quickstep program back and forth between
the controller and your computer.    The procedure below enables you to transfer a Quickstep .dso  file
from the computer to the controller.

 

WARNING:   Downloading programs to the controller can have serious
consequences that may injure people or equipment.  It should only be done by
experienced individuals who are  familiar with both the controller and the
application.

To download a Quickstep file from the controller to your computer:

1. Select Program Transfer (Quickstep Based) from the File menu:

2. The Program Transfer Utility pop-up appears:

http://www.ctc-control.com/customer/downloads/ctLoadLegacy/ctLoadSetup20.zip
http://www.ctc-control.com/customer/downloads/ctLoadLegacy/ctLoadSetup20.zip
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3. To upload the program from your controller to the computer, select the 2 button for Quickstep
Program Download:

4. Select the .dso file you want to download and click the Open button:
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5. You will see a pop-up asking you if you want to download the registers:

Select the Yes or No.

6. When the program transfer has completed you will see a pop-up similar to the following:

7. Click on the Exit button of the Program Transfer Utility pop-up to return to the main screen:
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Chapter 7:  Contacting
Technical Support

7.1 Contacting Technical Support

More information about Control Technology products and the Quickstep language may be obtained
from our staff of systems specialists. Call the numbers below for information.

Control Technology Corporation
25 South Street
Hopkinton, MA 01748

Telephone 508-435-9595
Toll Free 800-282-5008
FAX 508-435-2373
email customersupport@ctc-control.com

See us on the World Wide Web:  www.ctc-control.com

mailto:customersupport@ctc-control.com
http://www.ctc-control.com
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